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1. Introduction to Kernel for FAT and NTFS 

Welcome to the user manual for Kernel for FAT and NTFS, the most effective and easy to use data 
recovery software that helps you to recover data from lost, deleted, formatted and corrupted FAT and 
NTFS partitions on Windows 95, Windows 98, Windows ME, Windows 2000, Windows XP, Windows 2003, 
and Windows Vista hard disk or data storage media. This user manual comprises step by step guidelines 
on using Kernel for FAT and NTFS. 

1.1  Using this Manual 

This user manual is intended to guide users on using Kernel for FAT and NTFS. We suggest that first time 
users should read this user manual completely and carefully before proceeding to use the software. 
However, if you are an experienced user, you can use the table of contents to find out information 
pertaining to the tasks that you need to perform by using Kernel for FAT and NTFS. 

You can use the table of contents to navigate through different sections of this user manual. The table of 
contents lists all the sections that are contained in this user manual in chronological order. The user 
manual comprises the following sections: 

 Introduction 

 Getting Started 

 Software Interface 

 Recovering Windows Data 

 Full Version 

 Support 

 Troubleshooting 

 Legal Notices 

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual. 

1.1.1 List of Abbreviations 

FAT: File Allocation Table 

NTFS: New Technology File System 

RAM: Random Access Memory 

MB: Mega-Byte 
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GB: Giga-Byte 

1.2 About Kernel for FAT and NTFS 

Kernel for FAT and NTFS – Data Recovery Software is a software utility developed for data recovery 
from hard disk and other storage media. 

Kernel for FAT and NTFS – Windows Data Recovery Software recovers windows operating system data, 
lost due to following reasons: 

1. Format of a Windows installed hard drive 

2. Virus, worm, infected or corrupted files 

3. Partition structures are damaged or deleted 

4. Unexpected system shutdown or software failure 

5. Windows registry corruption 

Kernel for FAT and NTFS - Windows Data Recovery Software can recover files and folders from disks 
on which the following components have become corrupted (or even if they are completely missing): 

 Partition table (main or extended) 

 Boot Sectors (sometimes called "BIOS Parameter Block" or BPB) 

 File Allocation Table 

 Root Folders 

 Master File Table 

1.3 Salient Features 

Salient features of Kernel for FAT and NTFS include: 

 Recovery of deleted, damaged and inaccessible partitions 

 Recovery of missing files(s) and folder(s) 

 Data recovery after the loss of MBR, Boot sector or File Allocation Table corruptions 

 Recovery of data that was lost due to accidental formatting of your hard disk 

 Recovery of lost data due to variety of viruses(s) 

 Full support for long file names 
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 Recovery possible even if the disk partition has been formatted with different file system type or 
with different parameters 

 Recovery even if the MFT is corrupted 

 Full support for long file names 

 Full support for IDE, EIDE, SCSI and SATA, PAN, ZIP and USB drives 

 Live Update available for the software, to make sure that you always have the latest version of the 
software 

1.4 Who Should Use this Software? 

The capability and potential of Kernel for FAT and NTFS to recover deleted, damaged and formatted 
windows hard drive partition makes it appropriate for use by every computer user. Previously, the hard 
drive recovery was manually performed by professionals or experienced user. Now with Kernel for FAT 
and NTFS, any inexperienced or home user can easily use it to recover data from the corrupt, formatted 
and deleted partitions which leads to data loss scenarios. 

The data loss scenarios could have been caused due to accidental file deletion, file system corruptions, 
operating system corruptions, erroneous hard drive format operations and other logical problems to your 
computer system. 
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2. Getting Started 

Now that you have understood the features and potential of Kernel for FAT and NTFS, you are ready to 
get hands on experience of the software. To start windows data recovery, you will first need to download 
and install this software. 

It is strongly recommended that before installing Kernel for FAT and NTFS, you should go through the 
installation pre-requisites for the software to ensure that your computer is appropriately configured to run 
the software. 

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for FAT and NTFS can be broadly classified 
into two major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium Class Processor 

 Minimum 64MB RAM (128 MB recommended) 

 10MB for Software installation 

 Disk Space - Enough space to save the recovered data 

 You should have at-least 10 MB of free disk space if you want to save recovered 
data of 10 MB data. 

2.1.2 Software Requirements: 

The software requirements for installing the software can further be grouped into two categories – 
Operating system requirements and Supported file system requirements. 

The requirements are as follows: 

2.1.2.1 Operating System Requirements 

Supported Operating Systems: 

 Windows Vista 

 Windows XP 

 Windows 2003 

 Windows 2000 
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 Windows 98 

 Windows 95 

2.1.2.2  File System Requirements 

Supported file systems: 

 FAT16  

 FAT32  

 NTFS  

 HPFS 

 NTFS5 

2.2 Downloading Kernel for FAT and NTFS for the First Time 

After checking your computer with the prescribed system requirements for Kernel for FAT and NTFS, you 
can download and install the software on your computer. You can buy full version of the software from any 
one of our authorized resellers – Element5, Asknet and 2CO. 

If you want to try using Kernel for FAT and NTFS before buying it, you can download the evaluation 
version from the following link: 

http://www.nucleustechnologies.com/Download-Windows-Data-Recovery-Software.php 

 You can recover data from the corrupted, formatted or deleted Windows partition; 
however, you cannot save the recovered data with evaluation version of the 
software. 

2.3 Install Kernel for FAT and NTFS 

After downloading the installer file for Kernel for FAT and NTFS, you can install the software by running 
the file. To install Kernel for FAT and NTFS: 

1. Double-click the Kernel for FAT and NTFS installer. 

2. Follow the on-screen instructions. 

The Setup Installation Complete screen will be displayed. Click Finish to launch the software. 

2.4 Start Kernel for FAT and NTFS 

To start Kernel for FAT and NTFS: 

Click the Start  All Programs Kernel for FAT and NTFS 

http://www.nucleustechnologies.com/Download-Windows-Data-Recovery-Software.php
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Alternatively, you can launch Kernel for FAT and NTFS by double-clicking the shortcut icon available on 
the Desktop and Quick Launch icon. 

2.5 Uninstall Kernel for FAT and NTFS 

You may need to uninstall Kernel for FAT and NTFS. To uninstall Kernel for FAT and NTFS: 

1. Click the Start  All Programs Kernel for FAT and NTFS  Uninstall Kernel for FAT and NTFS 

A warning message will be displayed. 

2. Click Yes to uninstall Kernel for FAT and NTFS. 

 Before proceeding to uninstall Kernel for FAT and NTFS, you must ensure that the 
software is not running in system background. 

You can alternatively uninstall Kernel for FAT and NTFS from the Control Panel by performing the 
following steps: 

1. Click the Start Menu  Control Panel and then double click the Add or Remove Programs icon. 

2.  Select Kernel for FAT and NTFS and click Remove. A warning message will be displayed. 

3. Click Yes to uninstall Kernel for FAT and NTFS. 
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3. Software Interface 

Now that Kernel for FAT and NTFS has been installed on your computer, you can start using the software 
after getting acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel for FAT and NTFS comprises four main menus – Recovery, View, Tools and 
Help. 

3.1.1 Recovery Menu 

The Recovery menu comprises five menu items. 

 

Figure 3.1: Recovery Menu 

Menu items in the Recovery menu: 

Field Name Field Description 

Recover 
Selected 

Select to recover the selected files in the right pane of the window 

Recover All Select to recover all files in the right pane of the window 

Save Recovery 
Snapshot 

Select to save the scan information about the file(s) and folder(s) 
that have been found in the recovery process 

Load Recovery 
Snapshot 

Select to load the previously saved scan information. This option 
is disabled in Evaluation version 

Exit Select to close the software 
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3.1.2 View Menu 

The View menu comprises three menu items. 

 

Figure 3.2: View Menu 

Menu Items in the View menu: 

Field Name Field Description 

Icons Select to display the file(s) and folder(s) in 
windows standard small icon view style 

List Select to display the file(s) and folder(s) in 
windows standard list view style 

Details Select to display the details of the file(s) and 
folder(s) like File Size, Creation Date, and Type 
along with the name of the file or folder 

3.1.3 Tools Menu 

The Tools menu comprises five menu items. 

 

Figure 3.3: Tools Menu 
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Menu Items in the Tools menu: 

Field Name Field Description 

Find Files Select to search a particular file or file type in 
the data found 

Find Filters Select to filter only the file(s) that you want to 
recover and software will hide rest of the file(s) 

Settings Select to configure the settings of the software 

Drive Information  Select to retrieve the information about the file 
system being recovered 

Live Update  Select to get the latest version of the software 
available on Nucleus server 

3.1.4 Help Menu 

The Help menu comprises three menu items. 

 

Figure 3.4: Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

Contents Select to view help information pertaining to performing 
various tasks using Kernel for FAT and NTFS 

Buy Online Select to visit buy online page of software on our website 

About Kernel for FAT and Select to view version-related and support information of 
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NTFS Kernel for FAT and NTFS 

3.2 Tool-bar 

The tool-bar in Kernel for FAT and NTFS is displayed below the menu-bar. It provides a convenient and 
user-friendly method to perform certain actions that can also be performed by using the menu-bar. Read 
the information in the table below to find out about the tool-bar buttons: 

Button Button Name Button Description 

 

Recover 
selected 

Recover the selected files in the right pane of 
the window 

 

Recover All Recover all files in the right pane of the window. 

 

Save 
Recovery 
Snapshot: 

Save the scan information about the file(s) and 
folder(s) that have been found in the recovery 
process 

 

Load Recovery 
Snapshot  

Load the saved scan information  

 

Find File(s) Search for particular files in the current recovery 
session 

 

Settings This option configures the software. It provides 
the various options to control over the whole 
recovery process 
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Live Update Updates the current software with the available 
version in the Nucleus server 

3.3 Buttons Used 

Apart from the standard options available in the menu-bar and the tool-bar, the following buttons are 
displayed on the main and other windows. 

 

Click to start the recovery process 

 

Click to go back to the previous screen 

 

Click to stop the scanning process 
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4. Recovering Windows Data 

Now that you have complete familiarity of the user interface of Kernel for FAT and NTFS, you are ready to 
recover Windows data. 

To recover Windows data: 

1. Launch Kernel for FAT and NTFS. It shows all the detected drives in the left pane of the main window: 

2. Choose the appropriate Physical Drive where all your deleted files, corrupted or formatted partitions 
are located and then select the scan type. 

  Advance scan is recommended in case of recovering data from formatted partitions, 
OS re-installation and deletion of files long ago. 

3. After choosing the physical drive and the scan type, click  button to display all the available 
portions in the selected storage device. 

 If you don’t get your Logical Partitions listed, you can use the “Search for Partition” 
option 

4. Choose the logical drive or partition which has been formatted, corrupted to recover the file system in 

the selected partition. Click the  button to proceed with the scanning process. 

5. Kernel for FAT and NTFS displays the file systems found in the selected partition on the left pane of 

the window. Select the file system and click the  button to show the recovered files and folders 
in the right pane of the window. 

6. Select the files and folders that you want to recover and use Recover Selected and Recover All to 
save from Recovery menu. 

 It’s quite possible that Kernel for FAT and NTFS will show you more than one file 
system in the 5th step. Actually Kernel for FAT and NTFS uses very sophisticated 
algorithms for searching the data and identifying the file systems, so it would identify 
the file systems that you formatted long time ago. If you don’t find your data in the 
file system you selected then you will need to press Back button and select another 
file system. 

4.1 How to Recover Deleted Files? 

Know the steps to recover those files which were permanently deleted: 



© N u c l e u s  D a t a  R e c o v e r y . C o m  P r i v a t e  L i m i t e d   

1. Launch Kernel for FAT and NTFS and select the detected drive. Also select the Scan type for scanning 
the drive: 

 

Select Standard Scan option if the files were recently deleted or select the Advance Scan option if they 
were deleted long time back. 

2. Click the  button to continue. Software will display the available partitions for the selected drive 
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Select the appropriate partition to recover deleted files and folders. Click Search Partition button if you do 
not find the partition listed in the left panel from which you want to perform the file recovery. Software will 
start searching for the missing and deleted partitions. 

3. Click the button to continue. Software will display the recovered files from the selected 
partitions after thoroughly scanning the drive. 
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Files and Folders which were permanently deleted and are now recovered by the software are listed in 
Red color in the tree. 

  If the files and folders were not deleted recently then it is quite possible that you 
might not get the desired results while using Standard Scan. In this case you would 
need to select the Advance Scan and follow the same steps as described above. 
You may get the deleted folder(s) by virtual name like DIR123. You can rename the 
directories by pressing F2 on them. 

4.2 How to Recover from Missing Partitions? 

Use Advance Scan option of Kernel for FAT and NTFS to recover the lost and missing partitions. 

1. Launch the software and select the storage device from which you want to perform data recovery. 

2. Click the Search Partition button to search for the partitions. 
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Software will start searching for the missing partitions. It will display the detected partitions in the left 
panel. 
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Now select the appropriate partition and perform the data recovery. 

4.3 How to Recover from Formatted Partitions? 

With Kernel for FAT and NTFS you can recover the partitions that were formatted with the same or 
different file system: 

FAT32 Formatted as NTFS 

NTFS formatted as FAT32 

FAT16 formatted as FAT32 

FAT32 formatted as FAT16 

FAT16 formatted as NTFS 

NTFS formatted as FAT16 

1. Launch the software and select the Advance Scan mode for scanning the drive 

2. Software will display the list of partitions found (formatted/lost/missing) in the Logical Drive. 

 

Data can also be searched in sectors of the drive by typing the sector number and Kernel for FAT and 
NTFS will scan and recover from the mentioned sectors. 



© N u c l e u s  D a t a  R e c o v e r y . C o m  P r i v a t e  L i m i t e d   

3. After this, software will start scanning the drive and perform recovery of files and folders from the 
recovered partitions which were formatted, lost or missing. 
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5. Full Version 

Although you can use Kernel for FAT and NTFS evaluation version for free and experience the capabilities 
of the software, there are certain features that are not available in the evaluation version. 

5.1 Requirement of Full Version 

By using the evaluation version of Kernel for FAT and NTFS, you can recover and view the files and 
folders. However, you cannot save the recovered file(s) and folder(s).  

With evaluation version, you cannot utilize the Load Recovery Snapshot feature which enables you to load 
the saved scanning process. 

You will need to buy Full version of the software to save the recovered file(s) and folder(s) and to utilize 
the Load Recovery Snapshot option. 

5.2 Purchasing Full Version 

You can buy the full version of Kernel for FAT and NTFS from any one of our authorized resellers – 
Element5, Asknet and 2CO. 

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email 
comprising the URL to download the full version of Kernel for FAT and NTFS and activation details of the 
software. 
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6. Support 

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel for FAT and NTFS. The software comes with an embedded help manual that can be 
accessed by clicking HelpContents in the menu-bar. You can also press the F1 key on the keyboard of 
your computer to access the embedded help of Kernel for FAT and NTFS. 

You can access the online help for Kernel for FAT and NTFS at 
http://www.nucleustechnologies.com/Online-Helps.html 

View Animated Working Demo of the software at 
http://www.nucleustechnologies.com/Animated_Demo_Windows.html 

We also have live support wherein you can chat with our software experts at 
http://www.nucleustechnologies.com/Support.html  

To talk on phone with our software experts call: 

Help line:  
 

+91-9818725861 

1-866-348-7872 (Toll Free for USA/CANADA) 

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

  

http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/Animated_Demo_Windows.html
http://www.nucleustechnologies.com/Support.html
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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7. Troubleshooting 

This section deals with your generic and specific queries pertaining to using Kernel for FAT and NTFS. 

7.1 Common Issues 

Why does Kernel for FAT and NTFS have limitations in evaluation copy? 

The free evaluation version of Kernel for FAT and NTFS is intended to enable you to experience the 
capabilities of the software. You will need to buy the software to save the recovered data. 

7.2 Frequently Asked Questions 

How to Buy Kernel for FAT and NTFS? 

You can buy Kernel for FAT and NTFS online at http://www.nucleustechnologies.com/Buy-Windows-Data-
Recovery-Software.php  

I have lost my full version for Kernel for FAT and NTFS. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 

Will it recover the data from my Pen Drive? 

Yes, Kernel for FAT and NTFS completely supports data recovery from Hard Drives, USB Drives, Pen 
Drives, Zip Drives, SCSI disks, Jazz and many other type of storage media. 

I accidentally deleted the partitions and re-created the new partitions. After that I have copied 
some of my data back to new partitions. Will it recover from such cases? 

Yes, just use Advance Scan and select the whole drive to scan in the next step. It will recover whatever 
old data is intact. 

How much time will it take to scan my hard drive? 

Time for scanning the disk depends on the size of the disk, amount of data in the disk and physical 
condition of the disk. In general if you use full scan than it takes around 30 minutes to scan a 40 GB Hard 
Drive.  

http://www.nucleustechnologies.com/Buy-Windows-Data-Recovery-Software.php
http://www.nucleustechnologies.com/Buy-Windows-Data-Recovery-Software.php
mailto:sales@nucleustechnologies.com
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8. Legal Notices 

This section comprises the legal specification about Kernel for FAT and NTFS and the company 
NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

8.1 Copyright 

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual and 
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights 
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior 
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is 
assumed, however, with respect to the use of the information contained herein. 

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved. 

8.2 Trademark 

Nucleus Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, and MS-DOS are registered 
trademarks of Microsoft Corporation. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

8.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty 
with regard to this manual or any other information contained herein and here by expressly disclaims any 
implied warranties of merchantability or fitness for any particular purpose with regard to any of the 
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages 
incurred directly or indirectly from any technical or typographical errors or omissions contained herein or 
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary 
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or 
any other information contained herein or the use there of. 

8.4 License Agreement 

Kernel for FAT and NTFS Copyright © by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM 
PRIVATE LIMITED. The terms and conditions of this License describe the permitted use and users of 
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each Licensed Copy of Kernel for FAT and NTFS. For purposes of this License, if you have a valid 
license, you have the right to use a single Licensed Copy of Nucleus Kernel. 

Scope of License 

Each Licensed Copy of Kernel for FAT and NTFS may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All 
rights of any kind in Nucleus Kernel, which are not expressly granted in this License, are entirely and 
exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. You may not rent, 
lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on, 
Nucleus Kernel, nor permit anyone else to do so. You may not make access to Nucleus Kernel available 
to others in connection with a service bureau, application service provider, or similar business, nor permit 
anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for FAT and NTFS, and any and all accompanying software, files, data and materials, are 
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including Nucleus Kernel, must be thoroughly tested with 
non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of the 
copies of Nucleus Kernel covered by this License. This disclaimer of warranty constitutes an essential part 
of this License. In addition, in no event does NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 
authorize you or anyone else to use Kernel for FAT and NTFS in applications or systems where Kernel for 
FAT and NTFS failure to perform can reasonably be expected to result in a significant physical injury, or in 
loss of life. Any such use is entirely at your own risk, and you agree to hold NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED harmless from any and all claims or losses relating to such 
unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein. 

 Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by 
you shall not constitute, nor contribute to, a waiver by NUCLEUS DATA RECOVERY.COM PRIVATE 
LIMITED of any other or future violation of the same provision, or any other provision, of this License. 


